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Charities and Non-Profits (990)

THE BASICS OF DATA ENTRY FOR TAX-EXEMPT 
ORGANIZATION (990) RETURN ARE THE SAME AS 
FOR A 1040 RETURN. NAVIGATION THROUGH DATA 
ENTRY, FIELD- AND SCREEN-LEVEL HELP, AND 
KEYBOARD SHORTCUTS ALL FUNCTION AS THEY DO 
IN THE 1040 PROGRAM. SEE THE 2019 DRAKE TAX 
USER’S MANUAL FOR THE BASICS OF USING THE 
PROGRAM. (THE MANUAL IS AVAILABLE ON THE 
INSTALLATION CD AND ON THE DRAKE SUPPORT 
WEBSITE: SUPPORT.DRAKESOFTWARE.COM > 
TRAINING TOOLS > MANUALS.)

WHAT’S NEW IN DRAKE TAX FOR CHARITIES AND NON-PROFITS

Drake Tax programs its software according to the latest IRS rules and regulations. The 
2019 program reflects all IRS changes to forms, credits, and deductions. For specific 
details on the IRS’s changes, see the IRS instructions for individual forms for tax-
exempt organizations.

Changes to the Tax-Exempt (990) Package

Following are some IRS and tax law changes and updates to Drake Tax’s 990 program 

for the 2019 filing season:

IMPORTANT

Be sure to review the 2019 Drake Tax User’s Manual – 
available from the Support.DrakeSoftware.com website – 
for details on the changes to the tax program and prac‐
tice management tools such Update Manager, Scheduler, 
Client Status Manager, new security measures, such as 
two‐step authentication, and enhancements to other 
programs, such as SecureFilePro and Drake Accounting.
Tax Year 2019 7
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e-File 
Required

For an exempt organization with a tax year beginning on or after July 2, 2019, Forms 
990, 990-PF, and 990-EZ must be e-filed. For calendar year filers, the requirement 
will take place starting in tax year 2020. See “Electronic Filing Mandate” on page 38 
for details.

Phone 
Numbers

The officers’ phone numbers can now be entered on the OFF screen. If one of the offi-
cers is designated on the OFF screen as “Signs return,” that officer’s phone number 
will be used on the PIN screen.

Largest 
Program 

Services 

The program prints the three largest program services, measured by their total 
expenses, on lines 4a-4c of Form 990. All other entries on screen 4, Part III Achieve-
ments, will be totaled and printed on line 4d, “Other program services,” of Form 990. 
A check box was added to screen 4 to indicate the expenses for the program services 
(other than the three largest) that should flow on line 4d of Part III of Form 990. A 
separate statement, “SERVICES,” displaying each program entered on this screen, 
will be generated and attached to the return.

Better 
Diagnostics

An improved diagnostics page (generated in View/Print mode) for Part VI of Form 
990-EZ, helps organizations exempt under section 501(c)(3) file complete Forms 990-
EZ.

New 
Accounting 

Standards

Form 990 has been revised to reflect changes in the nonprofit accounting standard, 
ASU 2016-14; see instruction for Forms 990 and 990-PF for guidance on how to 
report fund balances on Forms 990 and 990-PF. For instructions in the tax program, 
open screen 10B, available from the 990 only section of the General tab of the Data 
Entry Menu, and view the field help for either the “Net assets without donor restric-
tions” or “Net assets with donor restrictions” fields. (Click in the field and press F1.)

For Form 990-PF filers, see screen 54, available from the Main Form section of the 
990PF tab of the Data Entry Menu.

Schedule B 
Changes

An organization other than a 501(c)(3), 4947(a)(1) trust, or sec. 527 organization is no 
longer required to report the names and address of its contributors on Schedule B, 
Schedule of Contributors, attached to its Form 990 or Form 990-EZ for taxable years 
ending or after December 31, 2018. This information, however, must be retained by 
the organization and presented to IRS upon request. The preparer should still enter this 
information on screen B, available from the Schedules A-G tab of the Data Entry 
Menu. As a result, Schedule B will be generated in View/Print mode that will not have 
names and address of the contributors, and a Schedule B worksheet (Wks Schedule B 
in View/Pint mode) with Schedule B information that include names and address of 
the contributors that should be kept on record.

See Rev. Proc. 2018-38 for more information about this revised filing requirement and 
help for a particular data entry within the tax program.

Changes Associated with Tax Reform: 

• The corporate tax rate is now a flat 21%. Trust tax rates have changed.
8 Tax Year 2019
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• The “Tax Computation Worksheet for Tax-Exempt UBI” supplemental worksheet 
(Wks TTAX in View/Print mode) for Form 990-T has been updated to reflect the 
changes in tax rates.

• Exempt organizations with multiple unrelated trade or businesses must report 
each trade or business separately, using Form 990-T and Form 990-T, Schedule 
M. Use a separate screen 81 for each trade or business. Charitable contributions 
are now reported in Part III of Form 990-T, available on screen 80. Screens 80 and 
81 are located on Form 990T tab.

• Section 4960 imposes an excise tax on any organization that pays to any covered 
employee more than $1 million in remuneration or pays an excess parachute pay-
ment during the year starting in 2018. Screen OFF was updated to automatically 
calculate the tax and answer corresponding questions on Form 990 and Form 990-
PF. The tax will be calculated if there is either excess executive compensation or 
parachute payment, and either Highest compensated employee or Former cov-
ered employee is selected. For more details, see sec. 4960, the IRS instructions 
for Form 990 or 990-PF, or click in any data entry field and press F1 for field 
helps.

• Section 4968 imposes an excise tax on the net investment income of certain pri-
vate colleges and universities. Use screen SCO, available from the Other Forms 
tab of the Data Entry Menu, to complete tests found in Sec. 4968 to determine if 
the organization is subject to this excise tax. If the organization has already deter-
mined that it is subject to the tax, complete Form 4720, Schedule O information 
on screen SCO and screen SCOR for any related organization. The program auto-
matically answers the related question of Form 990.

• All screens associated with foreign transactions are located on Foreign tab of the 
Data Entry Menu.

• Form 5471, Information Return of U.S. Persons with Respect to Certain Foreign 
Corporations, was updated to include changes in foreign provisions.

OTHER CHANGES TO DRAKE TAX

• The MISC screen, added to the Miscellaneous tab of the Data Entry Menu of the 
1041 package, includes fields to help preparers keep up with the production sched-
ule of a return: Date promised, Date picked up, how much the client was charged 
last year (the 2018 prep fees field), and a check box for indicating clients who did 
not pay their bill last year. This is preparer information only and has no affect on 
the return.

• The Disaster Designation field on the MISC screen is for entering the name of a 
federally designated disaster for those business entities that incurred disaster losses 
and that are subject to federal disaster rules. An entry in this field is printed across 
the top of the return but does not otherwise affect the return The field is limited to 
75 characters (including spaces).

• An option to Update Misc Codes on Screen 1, available during the update process 
(Last Year Data > Update Client 2018 to 2019) was added to the federal business 
packages. This option allows you to bring forward from Drake18 the miscella-
neous codes and drop lists you created last year. For more information on using 
these code fields, see “Miscellaneous Codes” in Chapter 5 of 2019 Drake Tax 
User’s Manual.
Tax Year 2019 9
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GETTING STARTED IN THE 990 PACKAGE

Some early tasks you may need to perform before working on a 990 return include 
creating a return (for new clients) or updating a return (for existing clients).

CREATING A RETURN

To create a new return in Drake Tax:

1. From the Home window, click Open/Create (or select File > Open/Create 
Returns, or press CTRL+O).

2. In the Open/Create a New Return dialog box, enter the organization’s nine-
digit identification number.

3. Click OK. Click Yes when asked if you want to create a new return.
4. In the New Return dialog box, select Tax Exempt - 990 and enter the organi-

zation’s name.
5. Click OK.

Screen 1 of the return is displayed. You can now begin entering header information for 
the organization.

UPDATING A PRIOR-YEAR RETURN

If you prepared the organization’s tax return last year, you must update it for use in 
2019.

Prior-year returns can be updated in three ways:

• A single return (updated one at a time) using Last Year Data > Update Clients 
2018 to 2019 (recommended)

• When you open an existing return from a prior year for the first time in the 2019 
program and are prompted to update it

• With all other returns in the program using Last Year Data > Update Clients 2018 
to 2019 (not recommended)

Drake Tax recommends using the first option (updating returns individually) to ensure 
that you update only those items in a return that you want updated.

NOTE
Use blank forms to help clients collect tax‐related data you will 
need. To access blank forms, from the Home window, go to Tools 
> Blank Forms and select the Tax Exempt tab. Select a form from 
the list and click Print.

NOTE Header information for all forms is completed on screen 1. For 
information on specific fields in screen 1, see “Header Information 
(Forms 990, 990‐EZ, 990‐PF, 990‐T, 990‐N)” on page 20.

NOTE If you open a prior‐year 990 return that was marked as “Final 
Return” the previous year, the program informs you that the 
return was marked as final before it prompts you to proceed.
10 Tax Year 2019
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COMPLETING SCHEDULES IN DRAKE TAX

Many of the schedules used in Forms 990, 990EZ, and 990PF require a narrative sum-
mary explaining certain entries, selections, and elections made on specific lines in the 
return. The schedules requiring such summaries have their own Supplement Infor-
mation screens for reporting these narrative summaries.

The Supplement Information screens can be accessed in several ways. For instance, 
screen O, used to provide narrative information for Schedule O, is available from 
either the Form 990/990EZ tab or Schedules H - R tab of the Data Entry Menu, or 
by typing the screen code O in the selector field of the Data Entry Menu and press-
ing ENTER.

The other schedules that require such supplemental information have screen links to 
the necessary supplemental screens. For instance, when completing Schedule D, there 
is a link on screen D (Figure 1) to open the needed Schedule D - Supplemental 
Information screen.

Figure 1: Link to Schedule D - Supplemental Information screen from screen D

INFO Screen Another way to access the Supplemental Information screens for the schedules is 
the INFO screen (figure below). Accessible from the Schedule H-R tab of the 990 
Data Entry Menu, the INFO screen has links to Supplement Information drop lists 
of all of other individual schedules, allowing you to quickly find the attachment you 
need.

All of these Supplemental Information 
screens function is the same manner. To 
use one—in this example, the Supple-
mental Information screen for Schedule 
D—take these steps:

1.   Either select Schedule D from the 
INFO screen, (figure at left) or open 
screen D and click the Schedule D Sup-
plemental Info link (see Figure 2 on 
page 12).
2.   From the Reference drop list, select 
the line numbers to be addressed. In the 

NOTE The SCH2 screen in a 990‐PF return is the same as the O screen in 
the 990 and 990‐EZ returns.
Tax Year 2019 11
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example on Figure 2 on page 12, the user has selected Escrow Account Liabil-
ity in order to address Part IV, line 2b of Schedule D. 

3. Under Explanation, type the narrative information. Note that there is a 9,000-
character limit for e-file.

4. If necessary, press PAGE DOWN to open a blank screen and add supplemental 
information for another line of Schedule D.

5. If necessary, select item D99 - General Explanation Attachment, for non-
line-specific general explanations. 

Data entered on the Supplemental Information screen is printed in the supplemental 
information section of the specified schedule. For example, the narrative from 
Figure 2 would be printed in the “Part XIII Supplemental Information” section on 
page 4 of Schedule D of Form 990.

Figure 2: Supplemental Information screen for Schedule D

FORM 990-N

Form 990-N, Electronic Notice (e-Postcard) for Tax-Exempt Organizations Not 
Required to File Form 990 or 990-EZ, is required for certain small tax-exempt organi-
zations.

To file the e-Postcard using Drake Tax, go to screen 1 for the organization and take the 
following steps:
12 Tax Year 2019



Drake Tax Manual Supplement: Tax-Exempt Form 990-EZ
1. Under the General Infor-
mation heading, select N - 
Form 990-N from the 
Form drop list (item #1 in 
figure at right).

2. At the bottom of the Gen-
eral Information sec-
tion, mark the 990-N 
Only check box to indicate 
that the organization’s 
gross receipts are normally 
not more than $50,000 
(item #2 in figure at right).

3. Go to the OFF screen 
(Screen Code: OFF) and 
complete the Officer Name and Title fields, enter an address (or select the Use 
entity address check box), and for at least one officer, select Principal officer.

Once any EF Messages have been eliminated, the 990-N information can be e-filed. A 
“Form 990-N Information” page (“Form 990-N” in View/Print mode) is generated 
with the return for informational and bookkeeping purposes.

FORM 990-EZ

Certain organizations can file Form 990-EZ, Short Form Return of Organization 
Exempt From Income Tax, instead of Form 990. If an organization’s gross receipts 
(total amounts received from all sources during its annual accounting period) are less 
than $200,000 and total assets at year-end are less than $500,000, it can file Form 990-
EZ instead.

On screen 1, select E - Form 990-EZ from the Form drop list in General Informa-
tion section.

FORM 990-EZ SCREENS

The following screens are specifically provided for completing Form 990-EZ. They 
are grouped under the 990-EZ only section of the Form 990/990EZ tab of the Data 
Entry Menu.

NOTE For information on signing a return prior to e‐file, see “Part II, 
Signature Block” on page 31.

Table 1: 990-EZ Screens Under Form 990/990EZ Tab

Screen Title/Section on Form 990-EZ

21 Part I, Revenue and Expenses

22 Parts II and III, Balance Sheet/Accomplishments

23 Part V, Other Information, Page 1
Tax Year 2019 13



Form 990-PF Drake Tax Manual Supplement: Tax-Exempt
FORM 990-PF

Form 990-PF must be filed by certain exempt private foundations; see the IRS Form 
990-PF instructions for specific information on who must file this form.

FORM 990-PF SCREENS

The 990-PF–specific screens are located under the Form 990PF tab (Figure 3).

Figure 3: Form 990PF tab in Drake Tax (partial menu)

Several screens, such as screen 1, the DEPR, OFF, and IND screens, and certain 
schedule (SCH or SC) screens, can also be found elsewhere in the menu, as they 
apply for multiple forms and not just the 990-PF.

24 Part VI, Section 501(c)(3) Only

O Schedule O, Supplemental Information

SCH3 Other Items

SCH5 Part I, Line 5c

SC21 Unreported Activities

SC40 Part I, Grants and Similar Amounts Paid

SC42 Part II, Other Assets/Liabilities

Table 1: 990-EZ Screens Under Form 990/990EZ Tab

Screen Title/Section on Form 990-EZ

NOTE See “COMP Screen” on page 25 for information on adjusting the 
calculated number of highly paid individuals and contractors in 
Part VI of Form 990‐EZ.
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Drake Tax Manual Supplement: Tax-Exempt Form 990-PF

 
‐

RECOMMENDED ORDER FOR COMPLETING FORM 990-P
The IRS recommends completing Form 990-PF in the following sequence (Table 2) to 
limit jumping from one part of the form to another.

Part I 
Additional 
Schedules

Additional schedules may be needed to complete the following lines from Part I (#2 in 
Table 2):

• Line 6a (Net gain or loss from sale of assets not on line 10) — Use screen SCH5.

• Line 10c (Gross profit or loss) — Use screen SCH7.

• Line 11 (Other income) — Use screen SC50 for subsidiary schedule.

Table 2: Form 990-PF, Recommended Order

Seq. Section Screens Notes

1 IV 55

2 I and II 52, 53, 54 For required schedules, see “Part I Addi-
tional Schedules” and “Part II Additional 
Schedules” (following).

3 Heading 1, 51

4 III SCH3 Select item 5 or 6 from Line Number drop 
list and enter a description and amount.

5 VII-A 57 Use screen SC57 to create a schedule for 
controlled entities.

6 VIII OFF Use the IND screen to enter data for inde-
pendent contractors.

7 IX-A through X 59 If an explanation is required for line 1e of 
Part X, use screen SC59, Reduction Expla-
nation.

8 XII, lines 1–4 60 Line 4 is calculated automatically in Drake.

9 V and VI 56

10 XII, lines 5–6 n/a Calculated automatically in Drake.

11 XI 60

12 XIII 61

13 VII-B 58

14 XIV – XVII 62–66

NOTES
More in‐depth information on completing Form 990‐PF is available
from FAQ item K (“Recommended Order for Completing Form 990
PF”). Click the FAQ link on any tab of the Data Entry Menu.

See “COMP Screen” on page 25 for information on adjusting the 
calculated number of highly paid individuals and contractors in 
Part VIII of Form 990‐PF.
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‐

• Line 19 (Depreciation) — Use screen DEPR for depreciation schedule. (The lines 
for Net Investment income and Adjusted net income on the DEPR screen are 
required for columns B and C of page 1 of Form 990-PF.)

• Line 23 (Other expenses) — Use screen DEPR for amortization schedule. (The 
lines for Net Investment income and Adjusted net income on the DEPR screen 
are required for columns B and C of page 1 of Form 990-PF).

Part II 
Additional 
Schedules

Additional schedules may be needed to complete the following lines from Part II (#2 
in Table 2 on page 15):

• Line 7 (Other notes/loans receivable) — Use screen SC14 (This produces state-
ment STM 135) and/or screen SCH3 (This produces statement STM 113).

• Lines 10a – 10c (Investments) — Use screen SC54.

• Line 11 (Investments – land, buildings...) — Use screen SC53 for subsidiary 
schedule (when required).

• Line 13 (Other investments) — Use screen SC53 for subsidiary schedule.

• Line 15 (Other assets) — Use screen SC53 for subsidiary schedule.

• Line 20 (Loans from officers, directors...) — Use screen SC55 (when required).

• Line 21 (Mortgages and other notes payable) — Use screen SC55.

• Line 22 (Other liabilities) — Use screen SC53 for subsidiary schedule.

Using Screen 
SCH2

Screen SCH2, General Explanation Attachment, allows you to attach explanations for 
certain parts of the Form 990-PF.

It is necessary to identify which part of the form is to be associated with the attached 
statement. To select a section of a form, choose an option from the Schedule drop list 
at the top of screen SCH2. Next, write an explanation in the Explanation field. Press 
PAGE DOWN as needed for additional attachments. Note that there is a 9,000-character 
limit for e-file.

PMT Screen Use the electronic payment screen (PMT) for payment on Form 990-PF, an amended 
990-PF, or an extension of time to file (Form 8868) only. The PMT screen can be 
accessed from the lower right corner of the Form 990PF tab of the Data Entry 
Menu, or by typing screen code PMT in the selector field and pressing ENTER.

NOTES
More in‐depth information on completing Form 990‐PF is available
from FAQ item K (“Recommended Order for Completing Form 990
PF”). Click the FAQ link on any tab of the Data Entry Menu.

See “COMP Screen” on page 25 for information on adjusting the 
calculated number of highly paid individuals and contractors in 
Part VIII of Form 990‐PF.

NOTES

The SCH2 screen can be used for other 990 return types. Note 
that screens O (for Schedule O, Supplemental Information) and 
SCH2 are the same. See “Schedule O, Supplemental Info.” on 
page 30 for more information.

If X ‐ General explanation attachment is selected from the 
Schedule drop list, the attachment will be e‐filed with an e‐
fileable return (990, 990‐EZ, or 990‐PF).
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Screen Code: 
PMT

By default, the program indicates that the entire balance is to be electronically with-
drawn on the return due date unless otherwise indicated using the Federal pmt 
amount and Requested pmt date override fields on screen PMT. If the return is 
e-filed on or before the due date for this type of return, the requested payment date 
cannot be later than the due date for this type of return. If the return is transmitted after 
the due date, the requested payment date cannot be later than the current date.

A Withdrawal Selection is required if the program is to direct tax authorities to elec-
tronically withdraw funds from the foundation’s account.

The name of the financial institution, the bank’s routing number (RTN), the client’s 
account number, and the type of account (checking or savings) are required. The RTN, 
account number, and type of account must be entered twice.

Finally, the PMT screen must indicate the return to which the payment data applies. 
Mark the box of the applicable return type (990PF, 8868, or Amended 990PF).

FORM 990-T

Form 990-T, Exempt Organization Business Income Tax Return, is used for:

• Reporting unrelated business income and tax liability

• Reporting proxy tax liability

• Claiming a refund paid by either a regulated investment company (RIC) or a real 
estate investment trust (REIT) on undistributed long-term capital gain

• Requesting a credit for certain federal excise taxes that have been paid

• Claiming Form 8941 credit for small-employer health insurance premiums

Based on the items listed above, an organization may need to complete Form 990-T in 
addition to its 990, 990-EZ, 990-PF, or 990-N return. See Form 990-T instructions to 
determine if an organization is required to file Form 990-T.

Form 990-T cannot be e-filed.

FORM 990-T SCREENS

All 990-T–specific screens are located under the Form 990T tab (Figure 4 on 
page 18).
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Figure 4: Form 990T tab

FORM 990

A tax-exempt organization under section 501(a) must file Form 990 if it has either:

• Gross receipts of $200,00 or more

• Total assets of $500,000 or more at the end of the tax year

For more information on who must file Form 990, see the Form 990 instructions pub-
lished by the IRS.

RECOMMENDED ORDER FOR COMPLETING FORM 990
The sequence shown in Table 3 on page 19 is suggested as an efficient method for 
completing a return for a tax-exempt organization. In general, complete the core form 
first, and then complete—alphabetically—Schedules A through O and Schedule R, 
except as specified in Table 3 on page 19. This order limits the need to jump back and 
forth from one part of the form to another, as certain later parts are required in order to 
complete earlier parts.

NOTE Screen 80 must include a selection for item G (organization type) 
in order for Form 990‐T to be produced correctly with the appro‐
priate tax calculated.

TIP
More details are available in FAQ item E (“Recommended Order 
for Completing Form 990”). Click the FAQ link on any tab of the 
Data Entry Menu.
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Table 3: Form 990, Recommended Order

Seq. Section Screens Notes

1 A – F; H(a) – M 
(heading)

1 and OFF This is the “Heading” section of Form 
990; item F is completed on screen 
OFF; item M is completed automatically 
based on resident state entered.

2 Schedule R R, R2, R3 Determine related organizations, disre-
garded entities, and joint ventures for 
which reporting will be required. (See 
Sch. R instructions; Form 990 instruc-
tions, Appendix F, Disregarded Entities 
and Joint Ventures).

3 Part VII, Section A OFF Officers, directors, trustees, key employ-
ees, and five highest-compensated 
employees. To adjust the number of indi-
viduals receiving more than $100,000, 
use the COMP screen 

4 Part VIII, IX, and X 8, 9, and 10

5 Header line G 1 Completed automatically in Drake Tax

6 Parts III, V, VII, XI, 
and XII

3, 4, 6, IND, 11

7 Schedule L L Complete if required; see Schedule L 
instructions.

8 VI 7 Transactions reported on Schedule L 
are relevant to determine independence 
of members of the governing body under 
Form 990, Part VI, line 1b.

9 I 2 Complete based on information derived 
from other parts of the form.

10 IV 5 Complete this section to determine 
which schedules must be completed.

11 Schedule O and 
any other applica-
ble schedules

Schedules A – 
G and Sched-
ules H – R tabs

12 II PIN; Setup info See “Part II, Signature Block” on 
page 31.
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HEADER INFORMATION (FORMS 990, 990-EZ, 990-PF, 990-T, 990-N)
Use screen 1 to complete the header section for a tax-exempt organization. Complete 
all applicable fields.

Foreign 
Address

If the organization has a foreign address, fill out the applicable fields in the Foreign 
ONLY section of screen 1.

Type of Form To indicate which form the organization is filing, select an option from the Form drop 
list in the General Information section of screen 1. (See Figure 1 on page 13.) If the 
only return being prepared is a 990-T and its related forms, mark the 990-T only box.

Form 
Columns

Screen 1 has separate columns 
indicating the header boxes 
for Forms 990, 990-EZ, and 
990-PF. For example, the 
“Exemption application pend-
ing” check box on screen 1 
(item #1 in figure at right) 
puts an “X” in box “B” of 
Forms 990 and 990-EZ, or an 
“X” in box “C” of Form 990-
PF. Note that not all questions 
are required for all forms.

Affiliate 
Listing 

(990 Only)

If the 990 is a group return filed for affiliates—if line “Ha” on screen 1 is 
answered “Yes”—but not all affiliates are included, two lists of affiliates must 
be attached to the return: a list of each local or subordinate organization 
included in the group return, and a list of each local or subordinate 
organization not included in the group return. Screen SCH4 is available for 
this purpose and includes fields for affiliate name, address, and EIN. Click the 
SCH4 link on screen 1 (item #2 in figure above). Mark the This organization 
is NOT included in th return check box on screen SCH4 to put an 

NOTE
Header information to be completed first are items A through F 
and H(a) through M. Item A is completed only fiscal‐year returns. 
Item F is completed on the Officer (OFF) screen, The “Gross 
receipts” line on page 1 (header item G) on Form 990 is completed 
automatically.

NOTES

Foreign address fields are locked to keep incorrect address 
data from being entered. Click the field to unlock foreign 
address fields throughout the return. Close the return and re‐
open it to re‐engage the lock for unused screens.

To use the foreign address fields, first type in the street 
address and city name, then enter in the first field the name of 
the foreign province or state, as appropriate. Select the appro‐
priate foreign country from the drop list, and then enter the 
postal code, if appropriate.
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organization on the second list.

Tax Year The program uses the current calendar tax year (beginning January 1 and ending 
December 31) by default. If the organization uses a fiscal year, enter the beginning 
and end dates in the If not calendar year box on screen 1 (Figure 5).

Figure 5: If not calendar year box on screen 1

SCHEDULE R
Once you have completed the header information on screen 1, the IRS recommends 
completing Schedule R, Related Organizations and Unrelated Partnerships. Schedule 
R is used to submit data regarding the organization’s relationships with other organi-
zations, both taxable and tax-exempt. The program has three screens (located on the 
Schedule H-R tab of the Data Entry Menu) for Schedule R, listed in Table 4.

To enter more entities, press PAGE DOWN to access new, blank fields.

PART VII, SECTION A
Screen code: OFF Once you have completed Schedule R, the IRS recommends completing Part VII, Sec-

tion A (“Compensation of Officers, Directors, Trustees, Key Employees, Highest 
Compensated Employees, and Independent Contractors”). Use the OFF screen, acces-
sible from the Form990/990EZ tab of the Data Entry Menu, to report this informa-

NOTE
The default data for the Name Control field on screen SCH4 is 
the four‐letter code used by the IRS to match the information to 
the affiliate. This is an override field and must be completed if 
the name of the affiliate has changed since the entity’s last filed 
return.

Table 4: Schedule R Screens

Screen Sections of Schedule R Covered

R Schedule R, Parts I (Disregarded Entities), II (Related Tax-Exempt Organiza-
tions), and III (Related Organizations Taxable as a Partnership)

R2 Schedule R, Parts IV (Related Organizations Taxable as a Corporation or 
Trust), V (Transactions With Related Organizations), and VI (Unrelated Organi-
zations Taxable as a Partnership)

R3 Schedule R, Part V, Line 1 (Related Organizations and Unrelated Partnerships)

NOTE
Schedule R is not required for all organizations. For information on 
which aspects of Schedule R must be completed by an organization, 
see the IRS instructions for Schedule R, or see the Screen Help on 
screens R, R2, and R3. (Click the Help icon on the screen toolbar or 
press CTRL+ALT+?.)
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tion, noting that information entered there is used to generate Part II of Schedule J 
(“Compensation Information”).

PARTS VIII, IX, AND X
Parts VIII, IX, and X of Form 990 comprise the financial statements for tax reporting 
purposes. These sections are accessed from screens 8, 9A, 9B, 10A, and 10B, 
accessed from the 990 Only section of the Form990/990EZ tab of the Data Entry 
Menu. (Figure 6)

Figure 6: Parts VIII, IX, and X are completed on screens 8, 9, 9B, 10A, and 10B

Statement of 
Revenue

The program has two screens for Part VIII, Statement of Revenue. Go to screen 8 to 
complete items 1 and 3 through 10. Press PAGE DOWN (or click the Lines 2 and 11 
link) to access fields for items 2 (“Program Service Revenue”) and 11 (“Miscella-
neous Revenue”).

Statement of 
Functional 

Expenses

Use the organization’s normal accounting method to complete Part IX, Statement of 
Functional Expenses. Part IX should not be used to report expenses that belong on 
lines 6b, 7b, 8b, 9b, or 10b of Part VIII, Statement of Revenue.

Part IX has two screens; to access the first screen (lines 1 though 14), go to screen 9A. 
To access the second screen (lines 15 through 26), press PAGE DOWN from screen 9A 
or go to screen 9B.

NOTE See “COMP Screen” on page 25 for information on adjusting the 
calculated amount in Part VII, Section A of Forms 990 and 990‐
EZ.
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Balance 
Sheet

All organizations must complete Part X. A substitute balance sheet cannot be used.

Part X has two screens: screen 10A (lines 1 through 15), and 10B (lines 17 through 
31). You can access screen 10B from screen 10A by pressing PAGE DOWN.

HEADER LINE G
The program calculates box “G” (gross receipts) of the form header automatically, 
based on the information entered on screen 8, (including the linked Line 2 and 11 
screen). 

PARTS III, V, VII, AND XI
Once you have completed screen 8 (both screens) for box “G” of the header, the IRS 
recommends completing Parts III, V, VII, and XI of Form 990 (screens 3, 4, 6, IND, 
and 11).

Purpose & 
Achievement

Part III, Statement of Program Service Accomplishments, requires that the organiza-
tion report its new, ongoing, and discontinued exempt purpose achievements, along 
with any related revenue and expenses.

In Drake Tax, Part III of Form 990 consists of two screens. Use screen 3 to answer 
items 1 through 3 (exempt purpose). Use screen 4 to complete the line 4 items (exempt 
purpose achievements). From screen 3, you can access screen 4 by pressing PAGE 
DOWN.

Exempt 
Purpose

Use the Primary exempt purpose field on screen 3 to describe the organization’s 
mission. The mission statement can address why the organization exists, what it hopes 
to accomplish, whom it intends to serve, and activities it will undertake and where. 
See IRS instructions for further information on what constitutes a mission.

If you answer Yes to question 2 or 3 on screen 3, use Schedule O (screen O) to 
describe any new services or changes to services. From screen 3, you can click the 

NOTES

Screen Help in the program provides further instructions on 
this section. To access Screen Help, hold your mouse pointer at 
the top of the screen for a moment until the data entry screen 
toolbar appears and click Help. Alternately, right‐click the 
screen and choose Screen Help from the right‐click menu, or 
press CTRL+ALT+? from the 9A or 9B screens).

For additional information on functional expenses, see the IRS 
instructions.

NOTE Some end‐of‐year amounts require separate schedules. Screens 
for these schedules can be accessed by clicking the applicable 
links on screens 10A, 10B, and 11.

NOTE
If the organization does not have a mission that has been adopted 

by its governing body, type None as the Primary exempt pur‐

pose.
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Sch O Screen link to access the Supplemental Information screen. From the Sched-
ule drop list of the Supplemental Information screen, select O22 (for line 2) or O23 
(for line 3).

See “Schedule O, Supplemental Info.” on page 30 for more information about filling 
out Schedule O in the program.

Exempt 
Achievement

Enter expenses, revenue, and a description of the exempt purpose achievements on 
screen 4. Examples of exempt achievements include:

• Providing charity care under a hospital’s charity care policy

• Providing higher education to students under a college’s degree program (the num-
ber of students served must be indicated)

• Making grants or providing assistance to individuals who were victims of a natural 
disaster

• Providing rehabilitation services to residents of a long-term care facility

Largest 
Program 

Services 

The program prints the three largest program services, measured by their total 
expenses, on lines 4a-4c of Form 990. All other entries on screen 4, Part III Achieve-
ments, will be totaled and printed on line 4d, “Other program services,” of Form 990. 
A check box was added to screen 4 to indicate the expenses for the program services 
(other than the three largest) that should flow on line 4d of Part III of Form 990. A 
separate statement, “SERVICES,” displaying each program entered on this screen, 
will be generated and attached to the return. For more, see the field help for the Mark 
this box...” check box at the bottom of screen 4. (Click in the check box and press F1.)

Acceptable exempt achievements do not include any achievement not substantially 
related to the accomplishment of the organization’s exempt purpose (other than by 
raising funds).

To enter a description that exceeds the allowed number of characters on screen 4, 
press PAGE DOWN and continue the description. There is no need to re-enter the
information in the top section of the screen. If the description takes up more space 
than is allowed on the printed return, the program generate sit on a separate page in 
View mode, the SERVICES page (Figure 7 on page 25).

NOTE The Program service code drop list on line 4 of screen 4 is not 
used.
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Figure 7: Part III of Form 990 refers to a SERVICES page for descriptions
that are too long to be printed on the actual 990 form.

To enter another achievement, press PAGE DOWN and mark the box labeled Mark this 
box if starting a new description. The second description entered is shown (or refer-
enced on a SERVICES page, if applicable (Figure 7) in section 4b of Part III. A third 
description is printed or referenced in section 4c. Additional descriptions are shown 
on additional SERVICES pages generated with the return.

Other IRS 
Filings

Part V, Statements Regarding Other IRS Filings and Tax Compliance, is used to show 
the organization’s compliance with the requirements of other federal tax laws for 
reporting and substantiation. Use screen 6 in the program to enter data for Part V. In 
Drake Tax, Part V consists of two screens: use screen 6 to answer items 1 through 6b; 
press PAGE DOWN from screen 6 to access items 7 through 14b.

Compen-
sation

Part VII reports compensation paid to officers, directors, trustees, key employees, 
highest-compensated employees, and independent contractors. For Form 990, 990-EZ, 
or 990-PF, use the OFF screen (for officers, etc.) and the IND screen (for independent 
contractors) to enter this information.

The OFF screen also has fields for entering an officer’s address, “books in care of” 
selection, and an indication of whether the specified officer signs the return or takes 
care of the organization’s books. The IND screens has fields for the name and address, 
type of service, and compensation of five contractors. (Press PAGE DOWN for the sec-
ond screen.)

COMP Screen Use the COMP screen (Figure 8 on page 26) to adjust the number of highly paid indi-
viduals—such as officers, contractors, directors, trustees, key employees—on 990, 
990EZ, and 990 PF returns.

Screen Code: 
COMP

The COMP screen is accessible from the Form 990/990EZ tab or from the 990PF tab 
of the Data Entry Menu.

NOTE The exempt achievement description has a 9,000–character limit 
for e‐file; if the description exceeds 9,000 characters, the return 
must be paper‐filed.
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Figure 8: COMP screen for High-Paid Individuals

Use the COMP screen:

• To adjust the number of individuals who received more than $100,000 (990 
returns). The number entered in Section A field of the COMP screen adjusts the 
number entered on the OFF screen.

• To adjust the number of contractors who received more than $100,000 (990 
returns). The number entered in the Section B field of the COMP screen adjusts 
the number entered on the IND screen.

• To adjust the number of employees (excluding officers, directors, trustees, or key 
employees) who received more than $100,000 (990-EZ returns). The number 
entered on line 50 of the 990-EZ Only section of the COMP screen adjusts the 
number entered on the OFF screen.

• To adjust the number of contractors (excluding the five highest compensated 
entered on the IND screen) who received more than $100,000 (990-EZ returns). 
The number entered on line 51 of the 990-EZ Only section of the COMP screen 
adjusts the number entered on the IND screen.

• To adjust the number of individuals (excluding the officers, directors, trustees, and 
key, employees listed on the OFF screen) who received more than or more than 
$50,000 (990-PF returns). The number entered on line 2 of the 990-PF Only sec-
tion of the COMP screen adjusts the entries on the OFF screen.

• To adjust the number of contractors (excluding the five highest compensated 
entered on the IND screen) who received more than $50,000 (990-PF returns). The 
number entered on line 3 of the 990-PF Only section of the COMP screen adjusts 
the entries on the IND screen.

Reconciling 
Net Assets

Enter the amount of changes in net assets or fund balances that occurred during the tax 
year on line 9 line of screen 11. These would include items such as prior-period adjust-
ments and changes in accruals.

Explain the changes on screen O, selecting code O26 in the Schedule drop list.
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Financial 
Statements & 

Reporting

Part XII, Financial Statements and Reporting, is used for reporting information on the 
organization’s accounting methods and financial statements. The accounting method 
(line 1 of Part XII) reflects the method indicated on screen 1. Use screen 11 to answer 
all other items for Part XII.

SCHEDULE L, TRANSACTIONS WITH INTERESTED PERSONS

Screen L (available on the Schedules H-R tab of the Data Entry Menu) contains 
fields for completing Parts I through IV of Schedule L, Transactions With Interested 
Persons. All or part of Schedule L may be required for certain organizations that file 
Forms 990 or 990-EZ. Schedule L is used for the following purposes:

• Reporting information on certain financial transactions or arrangements between 
the organization and disqualified persons under section 4958 or other interested 
persons

• Determining whether a member of an organization’s governing body is an indepen-
dent member for purposes of Form 990, Part VI, line 1b (“Enter the number of vot-
ing members who are independent”)

For information on which organizations must complete all or part of Schedule L, see 
Screen Help on the screen L (from the data entry screen toolbar, click Help, right-
click the screen and choose Screen Help, or press CTRL+ALT+?) or consult the IRS 
instructions.

PART VI, GOVERNANCE, MANAGEMENT, AND DISCLOSURE

Part VI, Governance, Management, and Disclosure, requests information regarding 
the governing body and management governance policies and disclosure practices. 
Although federal tax law generally does not mandate particular management struc-
tures, operational policies, or administrative practices, every organization is required 
to answer each question in Part VI.

Use screen 7 to access fields for Section A of Part VI. Press PAGE DOWN to access 
Sections B and C. If additional information is required for Part VI, use Schedule O 
(screen O; see “Schedule O, Supplemental Info.” on page 30). O Screen links are 
available on parts of screen 7.

PART I, SUMMARY

The summary section of Form 990 is for information regarding the mission, activities, 
and financial results of the organization. Use screen 2 to complete Form 990 Part I, 
Summary. (Line 1 of the “Summary” section of Part I flows from screen 3, line 1, Pri-
mary exempt purpose.) 

Number of 
Volunteers

Enter the number of full-time and part-time volunteers who provided volunteer ser-
vices to the organization during the reporting year. A reasonable estimate is acceptable 
if an exact number is not known. If the organization wishes to provide an explanation 
of how the number was determined, use Schedule O (screen O in the program; see 
“Schedule O, Supplemental Info.” on page 30).

Line 7b If the organization is not required to file Form 990-T, enter a zero (0) for line 7b.
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Lines 8–17 Prior-year amounts are updated automatically from the previous year’s return. These 
amounts can be entered or edited on screen 2.

PART IV, CHECKLIST OF REQUIRED SCHEDULES

An organization uses Part IV, Checklist of Required Schedules, to determine which 
schedules must be completed and filed with the tax return. In Drake Tax, two screens 
contain fields for Part IV. Open screen 5 to access “Yes” and “No” check boxes for 
lines 3 through 24d. Press PAGE DOWN from screen 5 to answers questions 25a 
through 37. Links gives you access to other appropriate screens. (See Figure 9.)

SCHEDULES

Use the Schedules A – G and Schedules H – R tabs of the Data Entry Menu to 
access schedules. Specific schedules can also be accessed using links within certain 
screens, such as screen 5 (Figure 9).

Figure 9: Links to schedules on screen 5 

Schedule A Schedule A, Public Charity Status and Public Support, provides information regarding 
public charity status and public support on Form 990 or Form 990-EZ.

Use the following screens to enter data for Schedule A:

• Screen A (Part I, Reason for Public Charity Status; required by all organizations 
filling out Schedule A.)

• Screen A2 (Part I, Line 12, Information about Supported Organizations)

• Screen A3 (Parts II and III, Support Schedules)

• Screen A4 (Part VI, Supporting Organizations)

• Screen A5 (Part V, Type III Non-Functionally Integrated 509(a)(3) Supporting 
Organizations)

NOTE
Some longer schedules require more than one screen to complete. 
For example, Schedule A consists of screens A, A2, A3, A4, and A5. 
You can access screens A2, A3, A4, and A5 from the Schedules A‐G 
tab of the Data Entry Menu.
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Schedule B, 
Contributors 

Use Schedule B, Schedule of Contributors, with Form 990, Form 990-EZ, or Form 
990-PF to provide information on certain contributions reported by the organization. 
Schedule B is required for contributions from at least one contributor in excess of 
$5,000. If there are no entries for the required Schedule B fields in the program, an EF 
Message is generated and the return cannot be e-filed. In Drake Tax, use screen B to 
enter Schedule B information.

See the field help for the Voluntarily disclose name and address of contributors... 
check box for more details. 

Schedule C, 
Political & 
Lobbying

Schedule C is required for certain section 501(c) organizations and section 527 organi-
zations filing Form 990 or Form 990-EZ. Use the following screens for Schedule C:

• Screen C — Parts I-A, I-B, and I-C

• Screen C1 — Part I-C, line 5 (names, addresses, and EINs of section 527 organiza-
tions to which payments were made)

• Screen C2 — Parts II-A and II-B

• Screen C3 — Parts III-A and III-B

See the IRS form instructions for who is required to file.

NOTES

Schedule A is required. At a minimum, amounts must be 
entered for the current year—even if the amounts are zero 
(“0”). If there are no entries for Schedule A, an EF Message is 
generated upon calculation, and the return cannot be e‐filed.

Field‐ and screen‐level help resources within the program pro‐
vide valuable supplemental information and tips for complet‐
ing Schedule A in Drake Tax. Press F1 for field‐level help. On 
screens A and A3, access Screen Help by clicking Help from the 
data entry screen toolbar, by pressing Ctrl+Alt+? from your 
keyboard, or by right‐clicking the screen and choosing Screen 
Help from the right‐click menu.

Screen A4 consists of two screens. From the first screen, press 
PAGE DOWN to access Sections B through E on the second 
screen.

NOTES
• Contributor information on Schedule B is not publicly disclosed.

• If Schedule B is not required, open screen 1 and mark the check box 
on line IV on the lower left side of the screen.
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Schedule D, 
Financial 

Statements

Filers of Form 990 should use Schedule D to provide the required reporting for the 
categories listed in Table 5. This table also shows which screens in Drake Tax are 
available for completing specific information.

Press PAGE DOWN to go to the next Schedule D screen.

To enter data for Parts VII through X, go to screen D4 and select the applicable part 
from the Part drop list (Figure 10).

Figure 10: Select the applicable part on screen D4 For parts VII through X.

Press PAGE DOWN to access a blank D4 screen and enter data for additional parts.

For information on completing Part XIII of Schedule D, see the “Schedule O, Supple-
mental Info.” section, following.

Schedule O, 
Supplemental 

Info.

The IRS provides Schedule O for filers who must include narrative information for 
specific lines. Use screen O to provide narrative information for Schedule O.

Table 5: Schedule D: Items Covered, and Screens Used

Category
Section of 

Schedule D
Screen to Use 
in Drake Tax

Donor-advised funds (DAFs) Part I D

Conservation easements Part II D

Certain art and museum collections Part III D2

Escrow accounts and custodial arrangements Part IV D2

Endowment funds Part V D3

Investments - Land, Buildings, Equipment Part VI D3

Investments - Land, Buildings, Equipment Part VI, line 1e 
(“Other”)

D1E

Supplemental financial information Parts VII through X D4

Supplemental financial statements Parts XI through XII D5

NOTE Note that Part VI, line 1e (“Other”) requires a separate screen 
from the previous Part VI information. Click the Line 1e detail 
link on screen D3 or press PAGE DOWN to open screen D1E.
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Screen O functions like the other “supplemental information” screens. For details, see 
“INFO Screen” on page 11.

Z Items Items beginning with “Z” in the Schedule drop list on screen O flow to Schedule O of 
Form 990-EZ.

PART II, SIGNATURE BLOCK

The signature block on Form 990 contains fields for up to two signatures:

• An officer of the organization

• The paid preparer (if applicable)

To e-file a return, enter the paid preparer’s and organization officer’s PINs on the PIN 
screen.

Note about 
Preparer ID 

Generally, anyone who is paid to prepare a return must sign the return and complete 
the other blanks in the “Paid Preparer’s Use Only” area of the return. An employee of 
a filing organization is not a paid preparer.

FILING AN EXTENSION

Calendar-year returns are due on May 15, 2020. If an organization uses a fiscal year, 
the return is due by the fifteenth day of the fifth month after the accounting period 
ends. By filing Form 8868, an organization can extend the deadline six months (to 
November 15 for a calendar-year return).

Use the 8868 screen (available from the Other Forms tab) to apply for an automatic 
sixth-month extension. (Figure 11 on page 32).

NOTES

All Form 990 or 990‐EZ filers must file Schedule O. Certain 
questions require all filers to provide an explanation in Sched‐
ule O. In general, answers can be explained or supplemented 
on screen O, using the Schedule drop list and Explanation text 
box.

To add a narrative explanation for an amended return, select 
AMD. See “Amending a Return” on page 32 for more on amend‐
ing a return.

To add a general explanation attachment, select X (located at 
the bottom of the drop list).

IMPORTANT
The applicable ERO or preparer PIN must be entered in 
Setup > Preparer(s) or Setup > Firm(s) in order to e-file 
a tax return. For more information on setting up firm, pre-
parer, and ERO information in Drake Tax, see Chapter 2 
of the 2019 Drake Tax User’s Manual.
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Figure 11: Mark the check box on screen 8868 to apply for an extension

AMENDING A RETURN

Indicate an amended return in the General Information section of screen 1. Note that 
an explanation is required on screen O for an amended 990 or 990-EZ return.

To provide an explanation for an amended return:

1. Open screen O.
2. From the Schedule drop list, select AMD - Amended return information 

(Figure 12).

Figure 12: The AMD selection on the Schedule drop list on screen O.

NOTE Form 8868, Application for Additional Extension of Time to File an 
Exempt Organization return can be e‐filed.

CAUTION
When you amend a return in Drake Tax, the amended infor‐
mation replaces the original in the data file. Before amend‐
ing a return, you should archive the original to avoid losing 
previously submitted data. For more information on 
archiving returns, see “Archive Manager” in Chapter 6 of 
the 2019 Drake Tax User’s Manual.
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3. Enter the explanation in the text box below the drop list. Character limit for e-file 
is 9,000 characters.

CREDITS TAB

General 
Business 

Credits

Use screen 3800 to claim current-year business credits that are not supported by Drake 
Tax. (Supported credits are listed on the right side of the Credits tab.)

Use screen GBC for reporting general business credit (GBC) and eligible small busi-
ness credit (ESBC) carrybacks and carryforwards, and to enter passive activity credit 
carryforwards.

For tax-exempt entities, use the CRED screen if you want to enter current-year pass-
through credits from pass-through entities (optional).

For details on using the 3800 and GBC screens, go to “General Business Credits” in 
Chapter 5 of 2019 Drake Tax User’s Manual.

Screens for computing foreign tax credits are listed on the left side of the Credits tab.

FORM 3115, APPLICATION FOR CHANGE IN ACCOUNTING METHOD

Form 3115, Application for Change in Accounting Method, is an application to the 
IRS to change either an entity’s overall accounting method or the accounting treat-
ment of any material item.

Form 3115 is eligible for e-file.

Drake Tax customers can fill out and e-file Forms 3115 and related schedules and 
attachments for 990 returns.

ACCESSING SCREENS FOR CHANGING ACCOUNTING METHOD

Several screens may be required to complete Form 3115. These screens are accessible 
from the Change in Accounting Method box, located under the Other Forms tab of 
the Data Entry Menu (Figure 13 on page 34).

IMPORTANT The amended return should include all information per-
taining to the return—not just the new or corrected data.

NOTES
In some cases, Form 3115 must still be paper‐filed.

Applicants filing Form 3115 should refer to Rev Proc. 2015‐13 
for general automatic change procedures, and to Rev Proc. 
2015‐14 for a list of automatic changes to which the automatic 
change procedures in Rev. Proc. 2015‐13 apply.
Tax Year 2019 33



Form 3115, Application for Change in Accounting Method Drake Tax Manual Supplement: Tax-Exempt
Figure 13: Screens for Form 3115, Application for Change in Accounting Method

The screens accessible from the Change in Accounting Method section include:

• Screen 3115 (Change in Accounting Method) — Used to access fields for Form 
3115, including Schedules A through D

• Screen 311E (Schedule E) — Used to request a change in depreciation or amorti-
zation methods

• Screen ATT (Explanations and Attachments) — Used to create and view certain 
attachments to be generated by the software

• Screen ATT2 (Pt II Ln 12 & Pt III Ln 23b Attachment) — Used to complete 
certain parts of Form 3115 that require specific attachments

FORM 3115 SCREENS

When you open the 3115 screen from the Data Entry Menu, the program displays the 
first of six 3115 screens. As shown in Figure 14, you can access these 3115 screens by 
clicking a link at the top of any other 3115 screen.

Figure 14: Tab links on 3115 screen
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Multi-form 
Codes

All 3115 and related screens contain a Multi-form code text box (shown in 
Figure 14 on page 34) that allows you to link a screen or attachment to a particular 
Form 3115.

If submitting more than one Form 3115, assign a multi-form code to each new appli-
cation you create in Drake Tax. The first should be “1,” the second “2,” and so on. 
When using other screens, such as the 311E or ATT screens, you can use those num-
bers to indicate which instance of Form 3115 the 311E or ATT screen should be asso-
ciated with.

Notices of 
Missing 

Attachments

In addition to Form 3115 and related schedules and statements, the program produces 
EF Messages (as applicable) when the return is calculated. All forms, schedules, EF 
Messages, and worksheets are accessible from View mode.

EF Messages for Form 3115 provide information about required attachments (includ-
ing PDF attachments) that are missing from the return. Some messages list all state-
ments required for a particular section but do not indicate which statements, 
specifically, are missing. To best understand which attachments are still required, 
compare the ATT screen and the statements (such as “Statement 465” and Statement 
2-15” in View/Print mode) to the list of missing statements and schedules in the EF 
Messages.

SAFE HARBOR ELECTIONS

Use the Building qualifies for Section 1.263... check box on screen DEPR to apply a 
small taxpayer Safe Harbor election to a building listed in the Description field. An 
election statement is produced and the building description as entered in the Descrip-
tion field is included in the election statement.

This Sec. 1.263(a) - 3(n) Election can also be made from the Elections drop list on the 
ELEC screen (available on the Miscellaneous tab), as can a Sec. 1.263(a) - 1(f) de 
minimis safe harbor election.

See IRS Reg. section 1.263(a)-3(h), IRB 2013-43, Rev. Proc. 2014-16, and Rev. Proc. 
2015-14 for guidance.

NOTE If only one Form 3115 is being submitted, you do not need to enter 
anything in the Multi‐form code box.

NOTE
All EF Messages must be eliminated before the return is eligible 
for e‐file. EF Messages for Form 3115 attachments are elimi‐
nated when all required statements have been attached to the 
return. 

NOTE This Safe Harbor election covers buildings only.
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BINARY ATTACHMENTS

Binary, or PDF, files can be attached to certain tax forms. These attachments are gen-
erally signature or third-party documents such as a copy of a signed lease or a signed 
appraisal statement. In some instances, the IRS requires that a document be attached 
to an e-filed return; in other instances, a document can be attached voluntarily to sup-
port or explain an entry in the return. In either case, a document must be in PDF for-
mat and attached to the return in order to be e-filed with it. Paper documents must be 
scanned into the computer to be attached.

Screen code: PDF Attach files through the PDF Attachments screen, accessible from the Electronic 
Filing section on the General tab of the Data Entry Menu.

For details on attaching documents to a return, see “Binary Attachments” in Chapter 5 
of 2019 Drake Tax User’s Manual.

PRINTING GENERATED DOCUMENTS

In some instances, Drake Tax generates a document that must be printed, signed, and 
scanned back into the computer to be attached to the return. An EF Message will state 
that attachments are required. You will then need to obtain and complete the state-
ments, scan them into the computer, save them as a PDF file, and attach them to the 
return.

USING THE PRNT SCREEN

Use the PRNT screen (accessible from the Form 990/990EZ or Miscellaneous tabs) 
to override some program defaults.

SUPPRESSING/FORCING ITEMS

To suppress or force printing of certain items, go the PRNT screen and select the 
desired options. Selections override the options established in Setup > Options. For 
more on setting up options globally in Drake Tax, see Chapter 2 of the 2019 Drake Tax 
User’s Manual.

The following items can be “forced” from the PRNT screen (see Figure 15 on 
page 37):

• Diagnostic summary report listing the forms calculated and providing a brief sum-
mary of the return

• Next-year depreciation listing for the organization

• Indication on the return that the organization has changed its accounting period

• Preparer’s name in the “Preparer’s signature” line for preparer and client copies of 
a return that has been e-filed

NOTE Directions for attaching documents can also be found in the 
Screen Help of the PDF Attachments screen, and in item L of 
the FAQ screen.
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Figure 15: PRNT screen options

The following items can be suppressed from the PRNT screen of a 990 return 
(Figure 15):

• Commas (in the amounts printed on the forms)

• Columns B, C, and D of Form 990, Part IX, if the organization is not a 501(c)(3) or 
501(c)(4) organization (Only Column A, “Total expenses,” would be generated for 
this section of Form 990.)

• Data for non-required fields on Form 990-T of gross receipts is $10,000 or less

• Proformas for next tax year

Overriding 
Other 

Options

Override the date to be printed on the return. To have no date printed on the return, 
close the return, and from the menu bar of the Home window, go to Setup > Options 
> Optional Items on Return tab and clear the Date on return check box.

Autobalance Autobalance forces the balance sheet to balance for both the beginning- and end-of-
year amounts by adjusting net assets or fund balance.

The program makes the adjustments due to differences in the balance sheet. Incorrect 
data entry could cause these differences but they are usually the result of amounts 
being erroneously deleted or changed from the balance sheet screens. To reconcile the 
differences, it is best to compare the organization’s beginning and ending balance 
sheet amounts for the tax year.

To turn off this feature for a specific return, select Turn off autobalance on the 
PRNT screen.
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ELECTRONIC FILING MANDATE

(New for 2019) For tax years beginning on or after July 2, 2019, an organization must 
electronically file Forms 990, 990-EZ, or 990-PF and related forms, schedules, and 
attachments. Calendar-year filers must e-file beginning in tax year 2020.

E-FILE EXCEPTIONS

There are some exception to the e-file requirements.

• A 2019 Form 990-EZ for a tax year beginning on or after July 2, 2019, must be 
e-filed unless one or more of the following exceptions apply:
– The name of the organization has changed, the new name is entered and the 

Change is Name box is selected for item B of screen 1 in Drake Tax.
– Form 990-EZ is for a short period because of an accounting period change. 

This does not apply if (a) the short period is an initial return and the Initial 
return box is selected in item B on screen 1; or (b) the short period is for a 
final return, and the Final return box is selected in item B on screen 1. 

– An application for exemption is filed and the Exemption application pend-
ing box is marked in item B of screen 1.

– Form 990-EZ is being filed before the end of the tax year. This does not apply 
if the return is a final return and the Final return box is marked in item B on 
screen 1.

– You attempted to e-file Form 990-EZ but the return was rejected (even after 
you contacted your e-file provider). For exceptions 1 through 4 above, file a 
paper Form 990-EZ.

– For this exception, paper-file Form 990-EZ as prescribed in section 5.7 of Pub. 
4163, Modernized e-File (MeF) Information for Authorized IRS e-File Providers for 
Business Returns.

NEW FOR 

2019

Filing instructions (federal and state) and envelope coversheets 
(partnership, IRS, state, and city) are no longer forced or sup‐
pressed from the PRNT screen; those options are now available 
from the COMM screen (formerly the LTR screen), available from 
the Miscellaneous tab of the Data Entry Menu. You can also click 
the Filing instructions and coversheet options link on the PRNT 
screen. Use the options on the COMM screen to override the global 
selections in Setup Options.

For more on global options and the COMM screen, see Chapter 2 of 
the 2019 Drake Tax User’s Manual.

NOTE
• A short period return cannot be e‐filed unless it is an initial return or

a final return (one of those boxes is marked on screen 1.)

• e‐File for Form 990‐T is not yet available. Once it is activated by the
IRS, these e‐file requirements will apply.
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The IRS may waive the e-file requirements in cases of undue hardship. For more 
information on filing a waiver, see Notice 2010-13, 2010-4 I.R.B. 327, available 
at IRS.gov/irb/2010-04_IRB

There are several listed consequences to not e-filing or filing a return.

• If there is an e-file requirement for the organization, and the return is paper-filed, 
the organization is considered to have not filed its return.

• If an organization does not file for three consecutive years, it automatically loses its 
tax-exempt status.

See the 990 Instructions and IRS Annual Filing and Forms page for details. 

HOW TO E-FILE

Steps for e-filing Form 990 are the same as for e-filing Form 1040. For detailed 
instructions on e-filing returns in Drake Tax, see 2019 Drake Tax User’s Manual.

For additional information on the e-file requirement, visit the IRS website at irs.gov. 
Click the Charities & Nonprofits tab.

IRS ERROR REJECT CODES

If any of the following IRS error reject codes is generated when e-filing a 990 return, 
the preparer must contact the IRS for further information. The IRS e-Help Desk tele-
phone number is (866) 255-0654

F990-902-01: The EIN in the return must have been established as an exempt organi-
zation return filer in the e-file database.

F990-913-01: Tax-exempt status specified in Item I, must match data in the e-file 
database.

F990-913-01: The “Return Type” indicated in the return header must match the return 
type established with the IRS for this EIN.

R0000-922-01: Filer’s EIN and Name Control in the Return Header must match data 
in the e-file database, unless “Name Change” or “Name or Address Change” check 
box is marked, if applicable.

OTHER AVAILABLE FORMS

Use Drake Tax to complete these other returns:

NOTE Although e‐file of Form 990‐EZ is required as described above, the 
IRS will continue to accept paper‐filed Forms 990‐EZ filed for tax 
years beginning before July 2, 2020.
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FORM 8976, NOTICE OF INTENT TO OPERATE UNDER SECTION 501(C)(4)
Use the links on screen 8976, Online Registration System (Figure 16) to connect to 
the IRS website and file Form 8976, Notice of Intent to Operate Under Section 
501(c)(4) tax-exempt organizations.

Figure 16: Links on screen 8976 to IRS Online Registration site and IRS Rev. Proc. 2016-41

Screen Code: 
8976

Most organizations must submit this notice within 60 days of their establishment. Fail-
ure to file this notice may result in penalties. This form can be filed only through the 
IRS website.

There is also a link on screen 8976 to connect you to the IRS Revenue Procedure that 
explains the form.

The 8976 screen is accessible from the Other Forms tab of the 990 Data Entry 
Menu.

FOREIGN TAB

In the Foreign Accounts and Assets section of the Foreign tab are screens FRGN 
and 114, used to complete and file FinCEN Report 114, Report of Foreign Bank and 
Financial Accounts, or Form 8938, Statement of Specified Foreign Financial Assets.

Screen 8938 is also used in completing Form 8938.

Use the screens in the Information Return Foreign Corporations section to com-
plete Form 5471, Information Return of U.S. Persons with Respect to Certain Foreign 
Corporations.

For more on completing and filing FinCEN Form 114, Form 8938, and Form 5471 in 
Drake Tax, see Chapter 5 of the 2019 Drake Tax User’s Manual.

OTHER PROGRAM IMPORTS
Information for outside worksheets can be imported into your 1120S return.

Form 4562 
Import

With the 4562 Import function, you can import depreciable assets into Drake Tax 
from Excel worksheets (Excel 97-2003 and Excel 2007/2010 or later), from a TAB 
(tab delimited) file, or a .CSV (comma separated value) file. After the import is com-
pleted, each asset or transaction appears on a separate 4562 screen.

To successfully import depreciable assets from a worksheet into Drake Tax, the work-
sheet must be correctly formatted. The best and quickest way to get a properly format-
ted Excel worksheet is to download a template from Drake Software. To do so:
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1. Open a client’s tax return.
2. From the Data Entry Menu toolbar, click Import > Form 4562 Import.
3. Click the Form 4562 Import information and sample spreadsheet link to open 

Drake Software Knowledge Base article 15982 on downloading the worksheet 
template. (Also in that article is a 4562 Import link to an instructional video.)

4. In the 15982 article, scroll down to “2018 - 990 Import Template.” Click to down-
load the template.

The worksheet is downloaded to your computer. Open it and save it where you can 
easily find it, such as the client’s file in Drake Tax, in Drake Documents, or on your 
desktop.

To use the 4562 Import feature:

1. Open a client’s tax return.
2. From the Data Entry Menu toolbar, click Import > Form 4562 Import.
3. When you are ready to begin the import process, click Next.
4. When the Form 4562 Import - Step 1 window is opened, click Browse, find your 

worksheet, click Open, then click Next.
5. When the Form 4562 Import - Step 2 window is opened, select the row where 

you wish to begin the import. (If the first row in the asset list is column headers, 
begin the import with row 2.) Click Next.

6. Click Import.

If you use an Excel worksheet from other sources, you can still import the asset infor-
mation into Drake Tax, but you need to aware of certain parameters. For the asset 
information to be imported correctly:

• In an Excel workbook, the import data must be on the first sheet in the workbook.
– View the workbook and check the tabs across the bottom of the window. If 

there is more than one tab, click and drag the worksheet you want to use to the 
left until it is the first tab.

– The name on the tab does not matter.
• The import file must contain the specified columns in the specified order. Each 

column represents a field on the 4562 screen as determined by the column loca-
tion (not by the header labels, which are optional)

• Except for column headers, do not put anything in the import file that should not 
be imported.

• If you include column headers, make sure to start importing on the first data row, 
not the header row. (Start import at row 2.)

• If totals are present, remove them. The totals may be imported, doubling your 
data.

NOTE If a column in the template is red, that column will not be imported into 
the return. 
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• The best way to enter dates in Excel is to format the date columns as text in 
MMDDYYYY format (separators can be used or omitted).

Importing Trial Balance Information

Drake Tax’s trial balance import feature allows data to be imported into an 1120S 
return from a trial balance worksheet. The trial balance template and importing func-
tion has the following benefits:

• Eliminates the need to duplicate entries
• Reduces data entry errors by automatically importing data to the correct fields

Allows preparers to merge basic accounting functions with tax preparation

TIP

Whether using the downloaded worksheet for the 4562 import or build-
ing your own, you can import the data more than once. When you are 
sure the correct data is imported, you can delete previous import 
attempts by opening the corresponding 4562 screens and pressing 
CTRL+D. 

For more help, see “Form 8949 Imports” in Chapter 5 of the 2019 
Drake Tax User’s Manual.

NOTE For more on the trial balance import, see “Importing Trial Balance 
Information” in the Drake Tax User’s Manual Supplement: 1120S.
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Index

A
accomplishments, statement of 23
accounting method

changing 33–35
accounting method used 27
address

"books in care of" 25
foreign 20
of 527 organization 29
of affiliates 20

adjustments to balance sheet 37
affiliates 20
amending a return 32
attachments

from within data entry 16
general explanation 16
PDF 36
to Form 3115 33

B
balance sheet

adjustments to 37
screens 23

blank forms 10
books in care of 25
business income returns (Form 990-T) 17

C
Change in Accounting Method 33–35
charity care for hospital 24
checklist of required schedules 28
codes

multi-form 35
commas, suppressing 37
COMP screen 25
compensation of officers, etc. 21, 25
contributors (Schedule B) 29
coversheets 38
creating a new return 10
credit for excise taxes 17

D
date (to print on return) 37
depreciation listing 36
diagnostic summary, printing a 36

disaster designation 9

E
e-file

exceptions 38
mandate 38
process 38

e-filing
and PIN signatures 31
Form 990-N (e-Postcard) 13
Form 990-T (not e-fileable) 17
PDF files 36

Elections
Safe Harbor 35

envelope coversheets 38
e-Postcards (Form 990-N) 12
error reject codes 39
exempt

achievement 24
purpose 23

expenses, statement of 22
extension, filing an 31

F
filing

an extension 31
filing instructions 38
final returns 10
financial statements

and reporting (Form 990, Part XI) 27
on Schedule D (Form 990) 30

FinCen Report 114 40
fiscal year, indicating a 21
foreign accounts 40
foreign addresses 20
Form 3115 (Application for Change in Accounting Meth-

od) 33–35
Form 8868, Application for Extension 31
Form 8938, Statement of Specified Foreign Financial As-

sets 40
Form 8976, Notice of Intent to Operate Under Section 

501(c)(4) 40
Form 990, Return of Org. Exempt from Income Tax 18–31
Form 990-EZ (short-form return) 13
Form 990-N (e-Postcard) 12
Form 990-PF (private foundations) 14–16
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Form 990-T (business income returns) 17–18
form type, selecting a 20
functional expenses 22

G
governance, management, & disclosure 27
gross receipts 23

H
header information 10, 20
higher education, provision of 24

I
import

4562 40
INFO screen 11
instructions for filing 38

L
lobbying activities (Schedule C) 29
long-term care services, provision of 24

M
Miscellaneous screen 9

N
Name Control field (screen 1) 20
narrative information, providing 30
natural disaster assistance 24
next-year depreciation listing 36

O
officer compensation 21, 25
order for completing

Form 990 18
Form 990-PF 15

other IRS filings and tax compliance 25
override

of setup options 37

P
partnerships, unrelated (Schedule R) 21
PDF files, e-filing 36
PIN signatures 31
political campaigns (Schedule C) 29
preparer signature 31
primary exempt purpose 23
prior-year returns, updating 10

private foundation return (Form 990-PF) 14–16
proxy tax liability 17
public status & support (Schedule A) 28

R
real estate investment trusts (REITs) 17
receipts, gross 23
regulated investment companies (RICs) 17
rehabilitation services 24
reject codes 39
related organizations (Schedule R) 21
required schedules, checklist of 28
returns

creating 10
updating from the prior year 10

revenue, statement of 22

S
Safe Harbor Elections 35
SCH2 (attachment) screen 16
Schedule A (Public Status and Support) 28
Schedule B (Schedule of Contributors) 29
Schedule C (Political Campaign and Lobbying Activities)

29
Schedule D (Financial Statements) 30
Schedule L (Transactions with Interested Persons) 27
Schedule O (Supplemental Information) 30
Schedule R (Related Organizations and Unrelated Partner-

ship) 21
Schedules

completing 11
schedules, checklist of required 28
SERVICES pages 24
short-form returns (Form 990-EZ) 13
signature block 31
statement

see also financial statements
of functional expenses 22
of program service accomplishments 23
of revenue 22

summary
on Form 990, Part I 27
report printing 36

supplemental information (Schedule O) 30
Supplemental Information screens 11
suppressing commas 37

T
tax

compliance statements (Part V of Form 990) 25
excise, credit for 17
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liability, reporting 17
year, specifying a 21

transactions (Schedule L) 27
trial balance import 42
type of form, selecting 20

U
unrelated business income, reporting 17
updating a prior-year return 10

V
volunteers 27
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